
Filmplakatens anatomi  
En guide til elementerne og en måde at komme igang



Hvorfor er plakaten vigtig?  
En forlængelse af filmens univers
 
Man kan være fristet til ikke at bruge så meget krudt på plakaten, fordi det jo er det “mindst vigtige”. Er det ikke federe at bruge så meget 
energi på at filmen bliver god som mulig, og så gemme plakaten til aller-aller-sidst? Den kan vi da hurtigt flikke sammen – eller hvad? 
 
Ikke helt. Plakaten er en vigtig forlængelse af filmens univers og fungerer, oveni at være en reklame for filmen, som et værktøj til at sætte 
publikums forventninger. Med andre ord: Hvad er det for en film, jeg skal ind og se? Folk bliver meget let forvirrede, hvis ikke filmen 
matcher overens med den måde, den bliver markedsført på, og reaktionen kan være vrede og skuffelse. Se f.eks. disse tænkte eksem-
pler. Mange af jer har sikkert set disse film. Ville I have set disse film, hvis I blot havde set disse plakater og intet andet? Synes I at de 
 kommunikerer filmenes stemning og tema ret godt?



Hvorfor er plakaten vigtig?  
Et eksempel på, når det går galt
 
En kvinde i USA sagsøgte biografer i Michigan, fordi hun følte 
sig vildledt af markedsføringen til filmen ‘Drive’ af den danske 
instruktør Nicolas Winding-Refn. Hun troede, at hun skulle 
ind og se en actionfyldt ‘The Fast and the Furious’-agtig film. 
Der blev lavet mange forskellige plakater til filmen (og dette er 
ikke engang dem alle sammen). Hvilken en af disse tror I at hun 
havde set?



Hvad er plakatens sprog? 
... og nogle gode tommelfingerregler
 
Generelt har I med plakaten tre værktøjer til at formidle filmens historie og “sælge” den rigtigt:

1. Fotoet, motiv, beskæring og farvelægning
2. Titlen, og den måde, den er skrevet på – font, farve etc.
3. Tagline

Nogle gode tommelfingerregler er:
• Hav en idé klar, før I går i gang. Kig i manuskriptet og find nogle nøglescener i filmen. Hvor-

dan kan disse omsættes til stillbilleder? Skitsér i blyant inden I  sætter jer ved computeren.
• Fotoet kan bære meget, hvis det er godt. Gå op i fotografiet og lad være med at tro, at man 

kan rette alt i Photohop. Hav en stillfotograf med på shoot så ofte som muligt – og især, når 
I optager nøglescenerne i filmen.

• Pas på ikke at overkomplicere tingene. Keep it simple! Det duer ikke med en indviklet idé 
som kræver timer og atter timer at stykke sammen i Photoshop. I er sandsynligvis heller ikke 
eksperter i programmet, så hold jer til det enkle. De bedste plakater er ofte også dem, som 
har en enkel idé og som kan udføres let. Når basics er på plads, kan I pudse plakaten af og 
gøre den lækker bagefter. Jo mere tid, I har til det, desto bedre bliver resultatet også.

• Det er tilladt at lade sig inspirere! Nogle gange er det nemmere at udtrykke  filmens genre 
og stil ved at læne sig op af etablerede klichéer. Og – når først man er klar over, hvilket sprog 
“konkurrenterne” har, kan man måske tillade sig at  begynde at lege med det. Men husk, at 
originialitet ikke nødvendigvis er en kvalitet, hvis det betyder at publikum bliver usikre på, 
hvordan plakaten skal tolkes.

• Hav flere øjne på, men ikke for mange. Det er altid godt at spørge andre i teamet til råds, 
men husk, at den der har ansvaret for plakaten også bør tage nogle beslutninger selv. Hvis I 
bliver for mange “kokke” om plakaten, kan det resultere i at også gode idéer bliver dømt ude. 
Kør flertals-demokrati fremfor konsensu-demokrati, hvor alle skal være enige.



Beskæring Fokusér på det vigtige
 
Billedet fortæller historien, men afhængig af hvordan det er beskåret, fortæller 
det også andre historier. Skær ned, skær ind og fokusér på det, der fortæller fil-
mens historie bedst! Eksemplerne på denne side er ganske vist ikke filmplakater, 
men demonsterer, hvordan man kan fortælle  forskellige historier med beskæring 
og mani pulere med folks opfattelse af virkeligheden.

Åbn dit billede, marker alt (cmd-A i Photoshop), skift til plakat-skabelonen og 
paste billedet ind (cmd-V). Nu skulle du gerne have dit billede som et separat 
lag. Dette lag kan du nu manipulere større eller mindre for at ændre beskæringen. 
Tryk cmd-T og træk i billedets hjørner for at ændre størrelsen. Husk at holde 
shift-tasten nede, såbilledet bliver strukket/klemt lige meget på begge ledder.



Komposition Plakatens visuelle balance og ro
 
For at opnå balance og ro i plakaten, er det vigtigt, at I tænker over kompositionen. Ovenfor ses en række grundkompositioner. Split, det gyldne 
snit, V, A, søjler diagonaler, figurativ formkomposition, krydset, cirklen og rækker. Der er mange flere. Find ud af hvilken opsætning, der klæder 
jeres foto bedst og eventuelt understøtter historien. Se næste side for en række eksempler på disse kompositioner i brug. Lav evt. små skitser 
med blyant i frimærkestørrelse for at finde ud af hvilken grundkomposition, der kunne klæde jeres foto, og så I ved, hvor I vil hen med plakaten.



Komposition Eksempler på grundkompositioner i brug
 
Hvad fortæller kompositionen om filmen? Hvordan understøtter det plakatens kommunikation?



Farver Slå filmens grundtone an
 
Farverne betyder meget for en plakat, og derer nogle genreklichéer, man kan benytte sig af.
Det er dog ikke altid, de benyttes, men her er nogle klassiske eksempler.

Brug værktøjerne i Photoshop til at justere på farverne i fotoet. Især:
Image > Adjustments > Color Balance
Image > Adjustments > Photo filter 
Image > Adjustments > Vibrance

Opret eventuelt Adjustment layers ovenpå jeres billedlag, så I altid kan fortryde og/eller omjustere farver osv.
Layer > New Adjustment Layer > (vælg herefter typen af justeringslag, I ønsker)

Thriller: Afdæmpede,
kolde farver. Blå 
toner, tæt på monok-
rom (dvs. næsten kun 
én farve i plakaten 
udover sort og hvid

Komedie: Lyst 
og luftigt. 
“Barbiedukke”-hud-
farver. Stærke farver i 
overskriften.

Action: Mørke, 
stærke farver. “Ild-
spektret” rød, orange, 
gul bruges meget

Socialrealistisk drama: 
Realistiske, afdæm-
pede farver – meget 
1:1 med virke-
ligheden.

Indie: Stærke, teg-
neserieagtigefarver. 
Baggrunden ofte 
holdt i én tone.

Science fiction: Mørke, 
stærke farver, ofte 
kolde og unaturlige 
toner. “Glow in the 
dark”-effekter.



Skrifttyper Vælg den rigtige type til filmens titel og genre
 
Det er vigtigt, at I tænker over, hvilken skrifttype, I bruger til filmens titel og i forhold til hvilken genre, filmen er.  
Tænk på titlen og den måde, den er skrevet på som en slags “logo” for filmen.  
 
På næste side ses en række eksempler på forskellige genrers kliché-skrifttyper.  Billedet herunder viser hvor meget  
variation i skrifttyperne, der kan være inden for samme genre – ja, endda, indenfor samme serie af film.

Tip til steder at finde skrifttyper:

www.dafont.com
www.1001fonts.com
www.fontsquirrel.com

På Mac dobbeltklikker du blot på skrifttypen 
for at installere den. Så åbnes et lille vindue
med et preview af skriften. Tryk på knappen
“Installer skrift”. Nogle skrifter ligger i zip-
filer, når du har downloadet dem og skal 
pakkes ud først.

Husk at overveje læseligheden nøje! Det 
nytter ikke noget med den vildeste spacy
skrift til jeres science-fiction projekt, hvis
ikke man kan læse, hvad der står.
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Skrifttyper Eksempler på genre-troper
 
Du har sikkert set de nedenstående skrifttyper i forbindelse med film i den nævnte genre!



Skrifttyper Credits
 
Credits er ofte sat med høje, smalle bogstaver i bunden af plakaten. 
Hvorfor? I gamle dage fik skuespillere og andre medvirkende skre-
vet ind i kontrakten, at deres navn skulle stå med en vis størrelse på 
plakaten. Hvordan løser man det, uden at hele plakaten bliver dæk-
ket af tekst? Man gør skriften smallere! Problem solved. Siden er det 
blevet lidt af en “trope” eller kliché, at sådan ser credit-tekst ud. I kan 
også finde på jeres egen måde at skrive credits på, men det er nem-
mere at få en filmplakat til at ligne en filmplakat med disse skrifter. 
Her på siden er der fem eksempler på skrifter, man kan bruge til det.
 
Tips: Husk at variere skriftstørrelse eller -tykkelse mellem navne og 
titler. Overvej om skuespillerne skal stå for sig eller sammen med 
alle de andre. Tænk på, at skriften også skal være læselig. Print evt. 
plakaten i sort/hvid, men i 1:1 størrelse, så I bedre kan vurdere det.

Brug Photoshops genvejstaster til at justere luften mellem bog-
staver og linjer. Hvis noget begynder at flimre for øjnene og 
bliver svært at læse, kan det være et tegn på, at der er for lidt luft. 
 Genvejstasten er alt-piletast op/ned for linjeafstand og alt-piletast 
højre/venstre for bogstavmellemrum.

PUDAESTEST, VOLOREM RE SIT INT LAUT QUIAEST OPTATQUAM, SINITAM 
EIUR? ET QUE NOBITI OMMOLUPTUR, VELESTIUM QUAE OCCUS DIT ADIPSAM, 
TEM SEQUO TE ESSUNDANDIT QUAM EOS QUO TEMPERIBUSANDI ATEM 
EXPLABO. CABORIAM CONSEQUODI BLA CONEMPORIBUS DENIHILLAB IUM 
ANISSIMA QUI DERIS ADISQUI DIPICIIS IUM QUODIGN IMETUM EA NULLA NE 
IUM EAQUI UTE NUSAM QUI AS UT LIGNISQUAM, ET VENDIORE CONSEQUE 

Univers 39 
Thin Ultra
Condesed

P U D A E S T E S T,  V O L O R E M  R E  S I T I N T L A U T Q U I A E S T O P TAT Q U A M ,  S I N I TA M  E I U R ?
E T Q U E  N O B I T I  O M M O L U P T U R ,  V E L E S T I U M  Q U A E  O C C U S  D I T A D I P S A M ,  T E M  S E Q U O  T E 
E S S U N D A N D I T Q U A M  E O S  Q U O  T E M P E R I B U S A N D I  AT E M  E X P L A B O .  C A B O R I A M  C O N S E Q U O D I 
B L A C O N E M P O R I B U S  D E N I H I L L A B  I U M  A N I S S I M A Q U I  D E R I S  A D I S Q U I  D I P I C I I S  I U M 
Q U O D I G N  I M E T U M  E A N U L L A N E  I U M  E A Q U I  U T E  N U S A M  Q U I

Triple
Condensed
Roman

PUDAESTEST, VOLOREM RE SIT INT LAUT QUIAEST OPTATQUAM, SINI-
TAM EIUR? ET QUE NOBITI OMMOLUPTUR, VELESTIUM QUAE OCCUS DIT 
ADIPSAM, TEM SEQUO TE ESSUNDANDIT QUAM EOS QUO TEMPERIBU-
SANDI ATEM EXPLABO. CABORIAM CONSEQUODI BLA CONEMPORIBUS 
DENIHILLAB IUM ANISSIMA QUI DERIS ADISQUI DIPICIIS IUM QUODIGN 
IMETUM EA NULLA NE IUM EAQUI UTE NUSAM QUI AS UT LIGNISQUAM, 

Franklin
Triple
Condensed

PUDAESTEST, VOLOREM RE SIT INT LAUT QUIAEST OPTATQUAM, SINITAM EIUR?
ET QUE NOBITI OMMOLUPTUR, VELESTIUM QUAE OCCUS DIT ADIPSAM, TEM 
SEQUO TE ESSUNDANDIT QUAM EOS QUO TEMPERIBUSANDI ATEM EXPLABO. 
CABORIAM CONSEQUODI BLA CONEMPORIBUS DENIHILLAB IUM ANISSIMA QUI 
DERIS ADISQUI DIPICIIS IUM QUODIGN IMETUM EA NULLA NE IUM EAQUI UTE 
NUSAM QUI AS UT LIGNISQUAM, ET VENDIORE CONSEQUE QUO EA DOLU

SF Movie
Poster  
Condensed

PUDAESTEST,  VOLOREM RE SIT  INT LAUT QUIAEST OPTATQUAM, SINITAM EIUR?
ET QUE NOBIT I  OMMOLUPTUR,  VELESTIUM QUAE OCCUS DIT  ADIPSAM, TEM SEQUO TE 
ESSUNDANDIT  QUAM EOS QUO TEMPER IBUSANDI  ATEM EXPLABO.  CABORIAM CONSE-
QUODI  BLA CONEMPORIBUS DENIHILLAB IUM ANISSIMA QUI  DER IS ADISQUI  DIPICI IS 
IUM QUODIGN IMETUM EA NULLA NE IUM EAQUI  UTE NUSAM QUI  AS UT L IGNISQUAM, 
ET VENDIORE CONSEQUE QUO EA DOLU

Bee Two



Tagline Udtryk filmens pointe i få ord
 
Hvordan skriver man en god tagline? Tænk på taglinen som sloganet for filmen, 
hvor man koger plottet eller pointen ned til et spørgsmål eller et motto. Det er 
tilladt at læne sig op af ordsprog mv., men tænk på at de også gerne skal kunne 
oversættes til engelsk på et tidspunkt. Her er nogle tip:

• Prøv at fange det centrale i filmen. Du behøver ikke summere det hele op. 
Skær ned!

• Taglinen kan fint være en replik – en one-liner,  
som en af skuespillerne fyrer af.

• Taglinen må gerne være sjov eller finurlig, selvom filmen er alvorlig.
• Prøv den af. F.eks. ved at fyre 10 taglines af en dag. Næste gang I mødes, så 

hør folk om, hvilke taglines de kunne huske. De, der er nemmest at huske, er 
ofte også de gode.

• Pas på at taglinen ikke bliver for indlysende. Clash of the Titans’ tagline var 
f.eks. Titans will clash! – hvilket jo ligesom allerede er med i titlen...

• Pas også på at taglinen ikke bliver generisk, dvs. hvis den kan klaskes på alle 
mulige andre film. Testen med at se, hvilke taglines, man kan huske er god til 
at afsløre disse.

 
Til højre er nogle af de bedste taglines nogensinde ifølge Taglineguru.com. 
Hent inspiration her: 
 
www.taglineguru.com/moviesurvey.html
www.filmsite.org/taglines.html

1. In space no one can hear you scream.
 Alien (1979)
2. Houston, we have a problem.
 Apollo 13 (1995)
3. They’re back.  
  Poltergeist II (1986)
4. We are not alone.
 Nærkontakt af tredje grad (1977)
5. Just when you thought it was  
safe to go back in the water.
 Dødens gab 2 (1978)
6. Who ya gonna call?
 Ghostbusters (1984)
7. A long time ago in a galaxy far, far away
  Star Wars (1977)
8. Be afraid.Be very afraid.
  The Fly (1986)
9. The list is life.
 Schindler’s List (1993)
10. Earth. It was fun while it lasted.
  Armageddon (1998)


